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Acceptance and Use of the Manual

Disclaimer
These Workshop Notes (“Manual”) are provided to you on
your attendance at the Training Workshop (“Workshop”)
conducted by Pronamics Pty Ltd of Unit 4, 38 Leonard
Crescent, Brendale, Queensland 4500 (“Pronamics”) at
Pronamics’ business premises or elsewhere in Australia as
agreed to by Pronamics, in the use and application of the
Pronamics software programs described as “Expert
Estimation V2014”, “Expert Estimation Genesis”, “Expert
Estimation Express”, “Expert Estimation Excelerate”, “Expert
Project”, “Expert Project Express” and “Cost to Complete”
(individually and collectively called “Products”). You have
enrolled in the Workshop to enhance your learning of the
application and use of one or more of the Products.

Outcomes from the Workshop
Upon enrolment in, and attendance at, the Workshop, you
are deemed to acknowledge that:
a. no promises, representations, warranties, assurances or
undertakings have been made or given to you by
either Pronamics, or any of its staff, associates, subcontractors, agents, the presenter of the Workshop or
the facility provider (individually and collectively called
in this Disclaimer “Pronamics”) in relation to the
outcomes to be gained or benefits to be obtained by
you upon attendance at the Workshop or your reliance
on the Manual on the completion of the Workshop;
b. you are deemed to be attending the Workshop to
further your existing knowledge of the Products and
what you learn from or are able to personally take from
the Workshop is entirely dependent of your own
knowledge of use of the Products, the standard of that
knowledge that you have already gained and the
extent of the use of the Products before attending the
Workshop; and
c. Pronamics is not liable to you for any loss, claims,
damages, expenses or outgoings (including, without
limitation, any loss of profit, indirect, consequential or
incidental loss, damage or injury) that you suffer as a
direct or indirect result of your attendance at the
Workshop, your reliance on the Manual after
completion of the Workshop or directly or indirectly
from changes in the operating characteristics of the
Products, your computer hardware or software
operating systems.

Upon acceptance and use of this Manual, you are also
deemed to acknowledge that:
a. this Manual has been compiled by Pronamics with all
possible due care and diligence to ensure that the
Manual is current at the date of the Workshop you
have attended;
b. this Manual is intended to be kept by you purely as a
reminder of the topics presented to you at the
Workshop and that no warranty is provided to you by
Pronamics that the Manual will contain the most
recent information in the use and application of the
Products in the future; and
c. Pronamics is not responsible to you for any loss, claims,
damages, expenses or outgoings (including, without
limitation, any loss of profit, indirect, consequential or
incidental loss, damage or injury) resulting from your
reliance on the Manual after completion of the
Workshop or directly or indirectly from changes in the
operating characteristics of the Products, your
computer hardware or software operating systems.

Copyright Ownership
This Manual is subject to copyright which is owned by
Pronamics regardless of whether a copyright warning
appears on the page or pages of this Manual. This Manual is
provided to you personally upon your attendance at the
Workshop and use by any person other than the person
who attended the Workshop is strictly forbidden. It will be
considered a breach of copyright should you copy, extract,
reproduce, transmit, transcribe, store in a retrieval system,
translate into any language or computer language, in any
form, medium or by any means, electronic, mechanical,
magnetic, optical or otherwise either in part or in full,
without the express written permission of Pronamics.

Trademarks
Trademarks owned by Pronamics are used and appear
throughout this Manual (“Trademarks”) and these
Trademarks may not be used, copied, extracted,
reproduced or re-printed in any format by you without the
express written permission of Pronamics.
© 1997 ‐ 2022 Pronamics Pty Ltd.
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INTRODUCTION
Expert Estimation is an industry leading, elemental estimating system that provides users with the ability to
intuitively design and input budget and quoting information. Expert Estimation is the estimating system for true
professionals.
Expert Estimation Excelerate provides the core functionality required to create professional quotes and budgets.
This edition is targeted towards anyone who demands accuracy in pricing quotes or establishing budgets.
Excelerate is designed to facilitate seamless collaboration through ‘out of the box’ multi-user capability, online
licencing, and client-server architecture. Data is easily reused within Expert Estimation Excelerate, with the ability
for each user to have multiple Library projects, as well as copy data to and from other Windows applications.
Excelerate also enables users to save external project files to the application for fast and convenient data transfers.
With report formatting options that include company name and logo, signature lines, and interactive graphs,
Expert Estimation ensures that your reports are clear, concise, accurate and professional.
Thoughtful design, intuitive functions, and a comprehensive Help feature combine to ensure that users become
familiar with the program in the shortest possible time. To assist with this, Introductory online training, along with
technical support, are included with your subscription. Unlike many programs, Expert Estimation does not require
the purchase of additional modules to be ready for use.
The direct contact we maintain with our clients ensures that Expert Estimation stays at the forefront of current
practices, and exceeds the dynamic requirements of the industries we support.
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BENEFITS OF EXPERT ESTIMATION
Here are some of the benefits that businesses can expect to gain by implementing Expert Estimation Excelerate.
o

Increased efficiency and accuracy by automating regular tasks and calculations.

o

Consistency across your organisation for both the production of and reporting on estimates.

o

Highly traceable and reviewable estimates.

o

Suitable for most industries – in fact, any industry that utilises accurate quoting and budgeting can use
Expert Estimation Excelerate.

o

Multiple users can work on the same project at the same time without the possibility of data loss through
overwriting of information.

o

Thoughtful design and intuitive layout.

o

Easy transfer of data to and from other standard Windows applications such as Microsoft Excel®.

o

Powerful and flexible Spread calculations.

o

E-mail product support provided by professional staff who have direct involvement in the development of
the product.

o

Introductory training included in the subscription price, and available online for easy access.
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MAIN FEATURE AREAS
Below is a list of the main features and their availability to users who have subscribed to Expert Estimation
Excelerate.

Image 1 – Expert Estimation Excelerate edition’s comprehensive features
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GENERAL OVERVIEW
Expert Estimation is a first principles estimating system. Originally designed for the infrastructure and engineering
industries, it is equally applicable to any industry that utilises elemental estimating today.
This Getting Started guide is not intended to describe how to quote or budget, but instead describes how Expert
Estimation handles this process.
Expert Estimation allows you to develop a schedule of Direct Cost items, or import these from client documents.
You may extend on these items by using cost estimates, which may be as simple or as complex as required.
To provide additional flexibility, group (or complex) resources can be used within each cost estimate.
Overhead cost items (indirect or preliminary costs) are quoted in the same way as direct cost items. Along with
your profit margin, overhead items are automatically spread over your direct cost items to produce your project’s
selling rates for final submission. Image 2 shows how the various parts of Expert Estimation interact.

Image 2 – Basic overview of the interactions within Expert Estimation
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Expert Estimation has four broad areas:






Direct Costs
Overhead Costs
Resources
Margin

Area

Specific Information

Direct Cost

Direct Cost items are those items that contribute
directly to the completion of the project. They may be
the items that will be submitted to the client in a quote
or budget report.
These items may be provided by the client as a project
schedule or list of required works (in a physical form or
electronically e.g. Excel) or self generated.

Overhead Cost

Overhead Costs are items that do not contribute to the
project directly. In a quote, they are not submitted to the
client, but must be recovered from the project.
These item values are spread proportionately over the
Direct Cost items when calculation sell values.

Resources

Resources are the most fundamental element of any
estimate and are used to construct the quoted costs for
Direct and Overhead Cost items.
The User defines a resource’s base rate and the quantity
of the resource used in various items.

Margin

Margin is the result of a markup percentage added to
a project based on a project’s quoted costs.
Like Overhead Cost items, margin is spread
proportionately across Direct Cost items when
calculation sell values.
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BEFORE YOU INSTALL
Recommended Requirements
To function effectively, most users of Expert Estimation will require a computer with the following recommended
specifications:
Client Application

Server Application

A multicore 64-b (x64) processor

A multicore 64-bit (x64) processor

8 gigabyte (GB) RAM

8 gigabyte (GB) RAM when installed locally with client
component
16 gigabyte (GB) RAM when installed centrally and less
than 5 users are connected.
16 gigabyte (GB) RAM when installed centrally plus
1 gigabyte (GB) RAM per connected client instance when
more than 5 users are connected.

2 gigabyte (GB) of available hard disk space
for installation of software

4 gigabyte (GB) of available hard disk space for
installation.
Storage space needs to be considered for the number of
projects on the server. Recommend 5 gigabyte (GB) per
100 projects.

DirectX 9 graphics device with WDDM 1.0 or
higher driver
1024 x 768 display (1920 x 1080 recommended)
with 32-bit colour
Windows Vista SP3, Windows 7 SP1, Windows 8 or
Windows 10
(Expert Estimation Excelerate does not run on
Windows XP or below)

Windows Vista SP3, Windows 7 SP1, Windows 8,
Windows 10, or Windows Server 2008 SP2 or above
(software does not run on Windows XP or below)

Microsoft .NET Framework 4.5 (included in installer)

Microsoft .NET Framework 4.5
(included with installer)

Expert Estimation requires activation to operate.
A periodic internet connection is required for ongoing
software activation (phone activation is not available)
Connection to the internet is required for submitting
error reports and usage information
A network connection is required for communication
with non-local servers

Note: Depending on the number and size of projects, and features used in the program, additional
RAM and CPU capacity may be required for optimal performance.
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INSTALLING AND ACTIVATING THE PRONAMICS
PRODUCT SELECTOR
The Pronamics Product Selector is an application used to manage the installation and updating of Expert
Estimation. For installation to be successful the user must have local administrator privileges to the location where
the software is being installed.

Installing the Pronamics Product Selector
1.

Download and run the application’s installation (.MSI) file using the latest download link provided.

Image 3 – Terms and conditions are displayed in the set up window

2.

When the Pronamics Product Selector Set up window is displayed, read and agree to the terms and
conditions by selecting the checkbox towards the bottom of the window to enable the Install button.

3.

Click Install to start the installation of the Pronamics Product Selector.

4.

Once the installation has completed click the Close button to finish the process.

Image 4 – A successful install of the Pronamics Product Selector

Note: The Pronamics Product Selector requires the .NET 4.5 framework to function correctly. If the
system the application is being installed on does not have .NET 4.5 it will be installed as part of the
Pronamics Product Selector.
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Activating the Pronamics Product Selector
After the Pronamics Product Selector has been installed, you will be prompted to enter a licence key to activate
the software. Entering the license key will also provide you with a list of products that are available for download.
1.

Double click on the Pronamics Product Selector icon on the desktop to open the application.

Image 5 – Enter the licence key to activate the Pronamics Product Selector

2.

Enter your licence key in the textbox provided and then click the OK button.
Note: When the key is entered the application contacts the Pronamics licencing server at
extranet.pronamics.com, requesting a list of products. For this to be successful the machine must have
access to this address. If the activation does not work correctly and no products are listed in the
Product Selector (see Image 6) this may suggest that you are not connected to the internet, or your
proxy is blocking connection to and from the licencing server.

Once activation has been completed a list of products will be displayed in the left pane of the window.

Image 6 – A list of available products displayed after successful activation of the Pronamics Product Selector
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INSTALLING AND UPDATING EXPERT ESTIMATION
Expert Estimation requires two components to be installed for it to function correctly; the Server and Shell.
The Server component is responsible for storing your projects, running calculations and managing
communication with other users. This application can be installed on your local computer, on a workmate’s
computer, a central server or even the cloud.
The Shell component manages the connection to Expert Estimation servers and launches the client application.
This component is generally installed on the user’s local system.

Installing the Expert Estimation Server Component
For installation of the Server component to be successful the user must have local administrator privileges to the
machine where the software is being installed.
1.

From within the Pronamics Product Selector, click Expert Estimation on the left window to see a list of
components available for installation.

2.

Click the Install button beside the Server component.

Image 7 – List of components available for installation

Note: The files required to install the Server component of Expert Estimation are downloaded by the
Product Selector from the Pronamics download server at
https://knowledgebase.pronamics.com.au/pronamics_download_links/expert_estimation_download_links.htm
For the installation of this component to be successful, the machine must have access to this address. If
the installation does not work correctly or an error message is displayed, this may suggest that you are not
connected to the internet or your proxy is blocking connection to and from the download server.
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3.

A licence agreement will be displayed and must be agreed to before installation can continue.

Image 8 – Expert Estimation licence agreement window

4.

Once the installation of both components has been completed, the Shell component can be used to connect
to the Server.

Installing the Expert Estimation Shell Component
The installation of the Expert Estimation Shell component works in a similar manner to the Server. However, you
do not require local administrator privileges for the install to be successful.
1.

From within the Pronamics Product Selector, click Expert Estimation on the left window to see a list of
components available for installation.

2.

Click the Install button beside the Shell component.

3.

A licence agreement will be displayed and must be agreed to before installation can continue.

4.

Once the installation has been completed the Expert Estimation icon will be created on the desktop for
launching the application.
Note: The files required to install the Shell component of Expert Estimation are downloaded by the
Product Selector from the Pronamics download server at
https://knowledgebase.pronamics.com.au/pronamics_download_links/expert_estimation_download_links.htm
For installation of this component to be successful the machine must have access to this address. If the
installation does not work correctly, or an error message is displayed, this may suggest that you are not
connected to the internet or your proxy is blocking connection to and from the download server.
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Updating an Expert Estimation Component
The updating of Expert Estimation is managed through the Pronamics Product Selector. Each time the Product
Selector is opened, it checks for the availability of new versions for each component. If there is an update available,
an Upgrade button will be displayed beside the relevant component.
To successfully upgrade the Server component, the user must have local administrator privileges on the machine
where the software has been installed. You do not require local administrator privileges to upgrade the Shell
component.
1.

Click the Upgrade button beside the component being updated.

Image 9 – An upgrade available for the Server and Shell components

2.

A licence agreement will be displayed and “I Agree” must be checked before the upgrade can continue.

3.

Once the upgrade has been completed press the OK button to finish the process.

Image 10 – A successful upgrade of an Expert Estimation component
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ACTIVATING EXPERT ESTIMATION
The first time Expert Estimation is opened after connecting to a server, a window will be displayed allowing the
user to activate the software.

Image 11 – Window used to activate Expert Estimation

1.

Enter your licence key in the textbox provided and click the Validate button. A list of available product editions
will be displayed in the multiline textbox at the bottom of the window.

2.

Select a product edition and click the Select button.

3.

If there are unused licences available for the selected edition, the software will activate and open the
Welcome window.
Note: When the key is entered the application contacts the Pronamics licencing server at
extranet.pronamics.com, requesting a licence. For this to be successful the machine must have access
to this address. If the activation does not work correctly this may suggest that you are not connected to
the internet or your proxy is blocking connection to and from the licencing server.
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STARTING EXPERT ESTIMATION
The application can be opened from your Windows Desktop by double-clicking on the Expert Estimation icon.

Image 12 – Expert Estimation icon is displayed on the Windows Desktop

The first screen that is displayed when opening Expert Estimation is the Select Server window.

Image 13 – Select Server window allows you to view and select applicable servers

Select Server Window
The Select Server window allows you to select the server to which you wish to connect. This window also allows
you to add or remove servers as required.
To launch the Expert Estimation application, select a server from the drop-down list and click the Connect button.
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Welcome Window
This is the first window that is displayed when Expert Estimation is opened. It can also be accessed by selecting
the File tab from the ribbon menu, and clicking Welcome on the left of the window.
A list of recently opened projects is displayed in the Recent Projects list on the left of the Welcome window.
This list is updated when you open a new project. Clicking on a project name from the Recent Projects list opens
the project.
The Welcome window also displays an information section to the right of the Recent Projects, and the latest news
from Pronamics at the bottom. The information section displays useful links to external sources of information and
training courses for Expert Estimation. The latest news section displays information about upcoming updates for
Expert Estimation and Expert Project, including new features lists.

Image 14 – Welcome window displays recently opened projects and information
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Main Application Workspace
Once a project has been opened, the ribbon menu allows for easy access to the most commonly used functions
of Expert Estimation. When a tab is selected the buttons in the ribbon update to correspond with the actions
available within that tab. When you are working in different areas of the application a contextual tab may be
available in the ribbon, giving you access to functions that are only available in that window.

Image 15 – Main workspace of Expert Estimation

A status bar is located at the bottom of the window. This displays information related to the project you have open,
and includes a count of the project messages, your server connection status, and progress bars.
Each window you open is displayed in its own tab below the ribbon menu. The window you are currently working
in is known as the active window.

Image 16 – Window tabs displayed below the ribbon menu

To switch between the different windows, click a tab to make it active. To close a tab, click on the x button on the
right of the tab.
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EXPERT ESTIMATION HELP
Expert Estimation is fully supported by an inbuilt Help feature as well as an online Knowledge base. To access this
feature, use the F1 key or select the SavvyHelp button on the ribbon menu.

Image 17 – Help button is available throughout the application in the ribbon menu

Opening SavvyHelp opens a contextual pane on the right-hand side of the window, providing you with an
explaination of the columns and functions available to users in a particular window in Expert Estimation.
SavvyHelp also gives you access to the Pronamics Online Knowledge Base. The Knowledge Base allows you to
search each window and function available in Expert Estimation while providing a detailed explanation for each
and answers to frequently asked questions.

Image 18 – Various help topics can be answered by the SavvyHelp pane

Note: Should you require more information to that contained within the SavvyHelp feature, please
contact Pronamics through the online support hub: https://pronamics.com.au/support-hub/
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SETTING OPTIONS
Project options can be accessed and changed through the Expert Estimation Options window (Image 19). To view
or change project options;
1.

Click File menu, then select the Options tab.

Image 19 –The Expert Estimation Options window allows users to change properties such as decimal point preferences, adding a company logo
to reports, and default cost estimate modes

2.

Select the relevant option you wish to change (General, Reports, Displayed Decimals, or Cost Estimates).

3.

Select OK to save changes.
Note: Using Expert Estimation with the default settings is suitable for most users.
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WORKING WITH PROJECTS
The Projects window gives you access to the projects available on your selected server.

Opening an Existing Project
1.

From the File menu, select Projects.

Image 20 – Projects window displays all available projects that can be accessed

2.

Select a project file. If the required project is not shown on the page, the list can be refreshed to show any new
projects have been added.

3.

Click the Open button.

When a project is successfully opened, you will be directed to the Workflow window as seen in Image 21.

Image 21 – Workflow window and a message are displayed once a project has been opened
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Creating a New Project
There are a number of options available when creating a new project. Projects may be created as a blank project,
copied from an existing template or standard project, or imported from a file. From the File menu, select New
1.

Click on the Blank button.

2.

Enter the new project’s name in the Name field.

3.

Select the Project Type applicable (this is a descriptive field that does not affect the project itself).

4.

Enter a description for the project into the Project Description field.

5.

Click the Create button.

Image 22 – Projects can be created using several means

Note: Newly opened projects will open by default to the Workflow window.
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Creating a Project Based on an Existing Project
1.

From the File menu, select New.

2.

Click the Based On button.

3.

Enter the new project’s name in the Name field.

4.

From the Based On dropdown, select the existing project on which the new project will be based.

5.

Select what Project Type the new project will be defined as.

6.

Enter a description for the project into the Project Description.

7.

Click the Create button.

Image 23 –The “Based On” window lists the projects available to be selected as a template.
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Importing a Project
1.

From the File menu, select New.

2.

Click the Import Project button.

Image 24 – Importing a project from the New menu

3.

Click the Select button.

4.

Navigate to the file that you wish to import and click Open.

Image 25 – Open window lists available projects in the specified location

5.

Click the Create button.
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Closing a Project
1.

From the File menu, select Close Project.

2.

You will be prompted to confirm that you wish to close the project.

Image 26 – Prompt displayed when closing a project

3.

Once the project is closed, you are returned to the File menu of Expert Estimation.

Exiting Expert Estimation
1.

To close an open project and exit the application, select Quit from the File menu.

2.

Before quitting Expert Estimation, users with open projects will be prompted to save any unsaved changes.

3.

Click Yes, No or Cancel to either save, discard or cancel any changes.
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NAVIGATING THROUGH EXPERT ESTIMATION
The information in Expert Estimation is divided up into a number of main areas or windows. The most
commonly used windows include the Direct Cost Schedule, Overhead Cost Schedule, Resource Explorer and
Project Summary.
Project Summary

Overhead Cost Schedule

Direct Cost Schedule

Resource Explorer

Image 27 – Menu buttons for each of the most frequently used windows in Expert Estimation

Available Windows
A more comprehensive listing of the windows available under the various menu tabs are listed in the table below.
More information about these windows can be found in the Expert Estimation Help system. To access these
windows navigate to the relevant Home, Analysis or Reports tabs, select the appropriate option in the ribbon
menu. The table below details each available window and the corresponding ribbon menu button.
Workflow

This window displays a basic workflow that Expert Estimation
follows to create a quote.

Project Properties

Allows the user to modify details such as the project description,
currency, display options and tax applicable to the project.

Global Defines

Allows the user to define variables that can be used throughout the
entire project e.g. Project Duration.

To Do List

Allows the user to record important items that are required for
completion during a project.

Resource Explorer

The Resource Explorer is used to add or edit resources in the project.

Quotation Comparisons

Quotation Comparisons are used to compare quotes for resources
from different suppliers and contractors.

Direct Cost Schedule

The Direct Cost Schedule window is used to assign resources,
access Cost Estimates, and import information from the client’s
quote schedule.

Overhead Cost Schedule

Indirect costs associated with the project can be entered into the
Overhead Cost Schedule.

Project Summary

This window displays a summary of all project costs and allows the
Estimator to apply margin to the project.

Spread Nominations

Allows you to nominate the markup that a particular schedule item
is to receive.

Spread Results

Allows the user to analyse the spread of overhead (indirect) costs,
adjustments and margin over each direct cost item.

SavvyHelp

Provides users with a brief description of the features within the
currently open window. The Help manual can be accessed from the
SavvyHelp panel.
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CONTEXT MENUS
Many commands in Expert Estimation are located in Context (or right click) menus.

Image 28 – Context menu displayed within the Direct Cost Schedule window

Project Messages
Project messages display a list of important warnings and error messages that relate to areas within the project.
Double clicking on the message will (in most instances) direct you to the line of the project that requires your
attention. These errors are updated automatically, and can be accessed from the Project Messages button in the
Home menu.
There are three types of messages that can appear within any project:
1.

Warning messages indicate the potential for a problem to exist in a particular area of the project.

2.

Error messages indicate an error that requires resolving in order for the project total to be calculated
accurately.

3.

Information messages provide the user with some useful information regarding their project that is neither
a warning nor an error.
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DIRECT COST SCHEDULE
The Direct Cost Schedule is a starting point for listing items which directly contribute to the project.
The estimate for each item is available through the Cost Estimate window.

Entering Direct Cost Information
From the Home menu, select the Direct Cost Schedule button from either the ribbon menu or the
Workflow window.

Image 29 – Direct Cost schedule

Information can be entered into the Direct Cost Schedule through various means including; manually entering
the information into any relevant cell, copying data from another project, and importing (pasting) the information
from an external source.

Entering Information Manually
To enter the information manually into the Direct Cost Schedule:
1.

Add a new schedule item.

2.

Click into the field of a column which you wish to complete.

3.

Type the relevant information.

4.

There may be some restrictions on the type of information that can be entered into each cell, including
numeric values, or fixed selections from drop-down menus.

Copying Direct Cost Items
It is possible to copy direct cost items from one project to another. To copy direct cost items:
1.

Open a project with the direct cost items you wish to copy.

2.

Navigate to the Direct Cost Schedule, highlight the line and select Copy from the ribbon menu.

3.

Open a new project, go to the Direct Cost Schedule and select the Paste button from the ribbon menu.
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Importing Items from an Excel Spreadsheet
Items appearing in the Direct Cost Schedule are usually listed in a similar fashion to their display in the client’s
original documentation. If it is possible to receive a suppliers quote in electronic format, (such as a spreadsheet),
copying existing data from the spreadsheet into the new project can save valuable time and minimise
possible errors.
1.

Open the spreadsheet containing the client’s schedule.

2.

Highlight the text and select Copy in your spreadsheet application.

3.

With the Direct Cost Schedule open, right-click on the line you wish to paste into and select Paste.

4.

The Paste Special window will appear prompting you to map your copied data to relevant columns
(as seen in Image 30)

5.

Press Paste.

Image 30 – Paste Special window

Note: Columns that are not labelled will not be imported into the schedule.
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Item State
An item’s state indicates where the item is in the quoting or budgeting process. Item state can be easily identified
by the change in the colour of its text.
To change an item’s state, scroll to the Item State column in the schedule or select Unfinish, Check or Finish in the
Properties section of the ribbon menu.
State

Colour

Description

Unfinished

Black

Unfinished items have not been completely quoted, and cannot be
calculated. The item’s cost estimate can be modified.
By default, Estimated Rates and Totals cannot be viewed, but may be
enabled in the Project Properties window.

Check

Maroon

Check is used when a quote has been completed for an item, but
needs to be highlighted for later review. Calculations will be performed
on items with a state of Check. However, the cost estimate cannot be
edited without changing the state to Unfinished.

Finished

Blue

Finished items have been completely quoted and can be included in
all calculations. When the item state is set to Finished, you cannot
change the cost estimate without first changing the status of the item
to Unfinished.

Note: The state for items can be changed at any time. To toggle between the Unfinished, Check and
Finished status use Ctrl+1 for Unfinished, Ctrl+2 for Check and Ctrl+3 for Finish.
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Formulae
Formulae may be entered into the Formula column in the Direct Costs window to calculate quantities or totals.
These lines are highlighted by default.

Image 31 – Direct Cost schedule with the formulae uses highlighting for easy identification

Valid formulae in the Direct Cost Schedule include:

Subtotal formula
𝑠𝑡(2: 12, 14: 17, 19, 25)
Displays the subtotal and rate for a quantity of 25 (the last parameter), of the totals on lines 2 to 12, 14 to 17 and 19.
If there is any text present in the Description field, it will be displayed on the Submission Schedule report along
with the total for the range specified. The subtotal formula can be used to calculate a per square metre cost for a
section of the project, or total similar lines to provide a more readable submission schedule to clients.

Sum formula
𝑠𝑢𝑚(2: 12, 14: 17,19)
Displays the sum of the totals on lines 2 to 12, 14 to 17 and 19. If there is any text present in the description fields,
it will be displayed on the Submission Schedule report along with the total for the range specified.

Mathematical formula
The schedule can utilise a wide range of mathematical formula. Please review the Expert Estimation Cost
Schedule Formula Knowledgebase Article:
https://knowledgebase.pronamics.com.au/expert_estimation/direct_costs/cost_schedule_formula_list.htm
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Item Properties
Use Item Properties to see details about resources, currencies, and reference details. The Properties pane within
Expert Estimation is a contextual feature that will appear on the right hand side in a separate window. It has the
ability to be used across multiple windows, and reflects the properties for every item selected.
To access additional properties of an item, use Alt+Enter or the Properties button on the ribbon toolbar anywhere
on the item and the Properties pane will appear on the right hand side of the window.

Image 32 – Properties pane for Direct Cost Items
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RESOURCES
Base Resources
Base resources are resources that form the building blocks of each estimate. They cannot be broken down into
any smaller components. For example, one man-hour for an office worker, one week of a company car, one hour
of an external contractor’s time, one week of a marketing advertisement and a promotional mouse pad could all
be Base resources.
Base resources are broken up into five types: Labour, Material, Plant, Subcontract, and Other.
Type

Example

L

Labour

Manager, Chef, IT Support Staff

M

Material

Promotional Items, Office Consumables Telephone, Trees, Spare Parts

P

Plant

Company Vehicles, Machinery/Infrastructure

S

Subcontract

Consultants, External Service Suppliers

O

Other

Fees, Insurances

To view or enter resources, click on the Resource Explorer icon from either the ribbon menu or the Workflow.

Image 33 – The Resource Explorer displays all the available resources that can be used within the project. The Resource Category Tree can be seen
in the left most pane of the window

The Resource Category Tree allows you to quickly view and categorise the resources within a project. Browsing
through the Resource Types (and corresponding subcategories) allowsthe user to filter the resources that are
currently displayed.
To view all resources in your current project, select the top level, All Resources.
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Creating New Resources
To add new resources to your current project:
1.

Click the Resource Explorer button from the Home Menu.

2.

Select Add Resource from the menu.

3.

The Add Resource window appears (Image 34).

4.

Once you have entered the minimum information (Resource Name, and Type) for the resource, click Create.

Image 34 – Add Resource window

Note: Each resource must have a unique name.

Using Libraries to Access Resources
To access the Linked Projects window of Expert Estimation, select Project Properties from the ribbon menu and
click Linked Projects. Selecting Edit from the ribbon menu and adding a library project will allow the resources
from the library to be available for use in your current project.
In a cost estimate, type the name of the resource you wish to utilise from the Library project into the Resource
Name field. This resource will then be copied from the Library project to your current project automatically. The
resource copied from the linked project will also appear in the Resource Explorer.
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COST ESTIMATE
The Cost Estimate is used to construct the quoted costs for each item in the Direct or Overhead Costs windows,
as well as Group Resources. In order to access a Cost Estimate, the schedule item or group resource must have
a quantity.

Viewing and Editing a Cost Estimate
1.

Open the Direct Costs window for your current project.

2.

Click on an existing item and select the View Cost Estimate button from the ribbon menu.

3.

The process for entering information into a cost estimate is similar to that of each of the schedule windows,
i.e. entered manually, copied from an existing project, or imported in from an external source.

Assigning Resources
Resources can be created as required, assigned from the current project, assigned from library project, or copied
from other projects.
1.

If you know the name of the resource, you can enter it in the Resource Name column.

2.

If you do not know the name, click in the Resource Name column, and select the drop-down icon to cycle
through the available resources.

Image 35 – Cost Estimate window displaying the resource allocation drop-down menu

3.

Select a resource to add it to the current Cost Estimate line.

4.

Type the quantity to use in the Quantity column.

5.

The Total column of that Cost Estimate line will now update.
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Express Resource Creation
To create a new resource directly from the Cost Estimate window:
1.

Enter the new resource name in the Resource field and press Enter.

2.

The Add Resource window will appear.

3.

Enter the new resources details in the New Resource window.

4.

Click OK to create the new resource.

5.

The new resource will now appear on the cost estimate line, as well as appearing in the Resource Explorer.

Using Formulae in the Cost Estimate
Formulae can be used in a cost estimate to calculate a quantity for a resource, add a percentage (for example,
material wastage) to a selection of lines, or subtotal a section of work. Any description that you may wish to input
to accompany the use of that formula can be entered in the Description column.

To enter a formula either:
1.

Type the formula into the Formula column or click the formula column and use Ctrl+Space to list the available
formulae.

2.

Select the formula to insert.

3.

Modify the formula for your situation.

To calculate a quantity for a line:
Enter an inline calculation in the Formula column in the following format:
(𝟐 𝒘𝒂𝒊𝒕𝒆𝒓𝒔 ∗ 𝟏. 𝟓 𝒉𝒓𝒔 ∗ 𝟔 𝒕𝒂𝒃𝒍𝒆𝒔) This formula would return a quantity of 18.00 for the line.

To add a percentage to a range of lines:
1.

Click in the Formula column and use Ctrl+Space.

2.

Click on the %( formula

3.

Edit the formula to reference the required lines and percentage.

For example:
%(𝟐: 𝟏𝟑, 𝟑𝟎)
This formula will add 30% to the total usage of resources found in lines 2 to 13.
A full list of available formulae may be obtained from the Expert Estimation Help system and Knowledge Base.
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GROUP RESOURCES
Group Resources are a combination of base resources (and sometimes other group resources) that are
constructed to represent a complete work activity.
This can be anything such as:
o

Supply and set up marquee.

o

Supply and arrange tables/settings.

o

Electrician to supply and fit lighting and P.A. system.

o

Advertising package.

The following diagram illustrates a possible group resource cost estimate.

Image 36 – A basic group resource cost estimate

Note: Expert Estimation will not allow you to use a Group Resource that contains itself to prevent a
circular reference.

Creating a Group Resource
Group Resources can be created as needed or copied from Library projects.
To create a new Group Resource:
1.

In the Resource Explorer, select the Add Resource button.

2.

Type the name of the group resource into the Name field.

3.

In the Type field, select Group.

4.

Enter a Unit and Base quantity for the Group Resource.

5.

Click the Create button to save the Group Resource.
Note: Once a resource has been created as a group resource it cannot be changed to a Labour,
Material, Plant, Subcontract or Other resource type.
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Group Resource Calculation
To construct and calculate the Cost Estimate for the Group Resource.
1.

Click on the resource and select View Cost Estimate. This Cost Estimate window allows you to enter the
resources required to produce the calculated rate of the group resource.

2.

When finished, press Ctrl+3 to save and mark the item as Finished. The Resource Explorer will show a
calculated rate for the estimate.
Note: The Cost Estimate for group resources can also be accessed from the Resource Explorer by
double-clicking on the Name column of a resource.
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OVERHEAD COST SCHEDULE
Overhead Costs are costs that are not directly linked to specific items of work incorporated in the project.
Sometimes called Intangible or Indirect costs, these usually include items such as Establishment Costs,
Insurances, Petty Cash, Phone, Indirect Wages, and Electricity.
This schedule creates a pool of costs which are usually spread over the entire project.

To view the Overhead Costs window:
1.

From the Home menu, select the Overhead Cost Schedule button from either the Ribbon menu or the
Workflow menu.

2.

The processes for manipulating data in the Overhead Costs window are identical to the Direct Costs window.
The difference is that the costs entered in this view will be spread over the Direct Cost items and not disclosed
to the client.

Image 37 – Overhead Cost Schedule
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PROJECT SUMMARY SCREEN
The Project Summary window displays a summary of all project costs, and allows the users to apply margin to the
project. Click the Project Summary button in the ribbon menu or the Workflow window to open the Project
Summary window.

Image 38 – Project Summary window summarising the direct and overhead costs, margin and project total value.

Estimated costs are broken up into Labour, Material, Plant, Subcontract and Other components.
To apply margin to a project, select the Edit button from the ribbon menu. Markup can then be applied to either
the estimated costs of a project or the project total. The required markup percentages can be entered in the
Margin Calculations area to build a pool of margin to be spread over the direct cost items.
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SPREADING
Direct Cost items will usually require Overhead Costs and/or margin to be proportioned over each item prior
to submitting to the client. If you’re simply preparing a budget and not submitting a quote, this step may not
be necessary.
The concept of spreading is that of distributing those quoted overhead costs and margins over the relevant items
of the project. Each contributing item in the Direct Costs window will receive a portion of the overheads and
margin etc. to form the Sell Rate and Total for the item. Spreading is performed after the Estimate calculation is
completed, when no unfinished items remain in the project.

Spread Nominations
By default all direct cost items receive a proportion of the total overhead cost and margin value. This may be used
if you believe the quantity of an item will change when the project is started, or to manipulate the Sell Rate and
Sell Total of a particular item. The value of all other items will change to apply the specified nomination to the
selected item; this means that the project total does not change.
Note: Changing the method of Nomination for an item merely changes the distribution of Overhead
Costs and Margin in the project. It does not affect the project total.
Nominations are completed in the Spread Nominations window by editing cells in the grid, or accessing the
Properties pane. To access the spread nominations window, select the Spread Nominations button from the
ribbon menu. Once you have located the item that you wish to nominate, select the nomination type that you
wish to apply to that particular item from the grid or Properties Pane. To save and view the change, click away
from the item once the allocation has been made, and click refresh.

Image 39 – Spread Nominations window with the Properties pane

Note: Refer to the Expert Estimation Knowledgebase for more information on Nomination methods:
https://knowledgebase.pronamics.com.au/expert_estimation/spread_nominations/spread_nominations.htm
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Spread Results
The Spread Results window displays a summary of the spread applied to each Direct Cost item, the calculated
Sell Rate (and Total), the effective markup and any nominated item values. To access the Spread Results, select
the Home menu, and click the Spread Results button from the ribbon menu.

Image 40 – Spread Results window

The information found in the Spread Results window is read-only and cannot be edited.
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PRINTING AND REPORTING
All Reports available within Expert Estimation can be previewed, exported, and printed. Values contained within
printed reports are accurate at the time of printing only – resolving errors or subsequent changes to estimates will
directly affect the values that appear in these reports. A watermark will appear on the report if project messages or
errors remain unresolved in the project at the time of reporting.
Each report can be formatted to suit your requirements. For example, the Submission Schedule can be formatted
to show signature lines, witness lines, tax and also display text and heading items.

Printing Reports
To preview and print reports;
1.

Go to the Reports tab.

2.

Click on the relevant report type.

3.

Once the report has been generated click on the Change>> button to format the report.

Image 41 – Submission Schedule with base formatting.

4.

Click the Print button to print.
Note: A watermark may appear in the background to warn that project errors exist.
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OTHER FEATURES
The features outlined in this Getting Started manual present a snapshot of the most commonly used features in
Expert Estimation.
Below is a list of some other features included in Expert Estimation that are not covered in this manual. Please
refer to the Expert Estimation Help system for more information on these features.
Quotation Comparisons

Analyse the quotations for multiple resources from multiple suppliers or
subcontractors and transfer the rates from the selected quoter directly to the
resource database.

Currency

Use as many currencies in a project as required. This feature is a must when
sourcing resources internationally, or bidding for projects in other countries.
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GLOSSARY
Base Quantity

The quantity on which a group resource has been estimated. It does not
necessarily bare any resemblance to the actual quantity in the project as Expert
Estimation will ensure that the correct amount is included in the project.

Base Resource

An identifiable, physical item that has a cost and can be assigned to a work item.
Expert Estimation has five types of Base Resources: Labour, Material, Plant,
Subcontract, and Other.

Checked

A state for an item or Group resource, showing that the estimation of the item
requires a review prior to being marked as finished.

Confirmed

The term used when a quotation for a resource rate has been received.

Current Project

The project that is currently open in Expert Estimation.

Direct Cost Schedule

The schedule which makes up the project’s work elements.

Finished

A state for an item or Group resource, showing that the estimation of the item is
complete.

Group Resource

An identifiable, physical work process that can be costed and assigned to a work
item as a resource.

Linked project

A project used as a library to access resources either centrally maintained or
recently updated.

Margin

The amount of money added for profit to a project’s estimated cost.

Nominated Percentage
Markup

A percentage markup defined for a schedule item. A percentage nomination
does not alter the project’s value, only the distribution of Margin and/or
Overhead costs between Direct Cost items.

Nominated Rate

A rate for a schedule item to possess in the final project submission. A rate
nomination does not alter the project’s value, only the distribution of Margin
and/or Overhead costs between Direct Cost items.

Nominated Total

A total for a schedule item to possess in the final project submission. A total
nomination does not alter the project’s value, only the distribution of Margin
and/or Overhead costs between Direct Cost items.

Open project

The project which is being quoted/budgeted at this time.

Overhead Cost Schedule

The schedule in which indirect costs are entered and displayed. Overhead costs
are not displayed directly to the client, but their recovery is still required.

Plugged

The term used when one has estimated the rate for a resource, but a quotation
is not available.

Resource

A physical item which has a cost for consumption and can be assigned to a cost
item. See also Base Resource and Group Resource.
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Resource usage

The total number of units of a resource used in a project. Resource usage of a
subset of items can also be calculated.

Schedule

The list of work items provided by the client or created by the quote. Also see
Direct Cost schedule.

Unit

The means by which the resource or item is measured.

Unfinished

The initial state of an Item or Group Resource signifying that the costing of the
item is incomplete. A state of Unfinished on any item or Group Resource will
ensure that a spread calculation cannot be completed.

Unplugged

The term used when one is confident of the rate for a resource, but a quotation
is not available.
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EXPERT ESTIMATION TRAINING COURSES
INTRODUCTORY EXPERT ESTIMATION EXCELERATE
OVERVIEW
The course introduces users to the fundamentals of using Expert Estimation Excelerate. Participants will gain
familiarity with the Expert Estimation Excelerate environment as well as learn how to use the different
components of the program to efficiently create quotes and budgets. Each chapter contains a set of lab exercises
that reinforce learnt concepts and build upon the last to create a basic estimate.
This training course is not intended to describe how to estimate but rather how Expert Estimation Excelerate
handles the process of estimating and budgeting.

AIM
The Introductory course aims to provide attendees with the skills and confidence to quickly develop accurate
estimates using Expert Estimation Excelerate.
The course is intended for users with little or no experience with Expert Estimation Excelerate. It is also
recommended for individuals who use Expert Estimation Excelerate but have not attended a training course as it
reinforces key fundamentals of using the software.

PREREQUISITES
It is assumed that participants are already familiar with the common controls found in Windows.

COURSE COMPLETION
At the completion of the Introductory Expert Estimation Excelerate training course, participants have been shown
how to:

o

Efficiently navigate throughout Expert Estimation Excelerate.

o

Manage and work with new and existing projects.

o

Create, modify and import cost items into the Direct and Overhead Cost schedules.

o

Work with Base Resources within the program.

o

Make use of basic formulae to summarise costs on the schedule and in cost estimates.

o

Apply margin to the projects’ values.

o

Analyse different forms of data contained in the budgets and quotes.

o

Create and print reports using the data from Expert Estimation Excelerate projects.
For more information contact the Training Department on + 61 7 3481 9686 or
training@pronamics.com.au
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COURSE OUTLINE

o

Using Resources in the Cost Estimate

o

Using Basic Formulas

LESSON 1 – OPENING AND NAVIGATING

o

Deleting Cost Estimate Lines

o

Basic Navigation

o

Project Maintenance

o

Renaming a project

LESSON 6 – UPDATING SCHEDULE

o

Item State

o

Excluding Items

LESSON 2 – CREATE PROJECT

o

Provisional Sums

o

Importing a Project into Expert Estimation
Excelerate

o

Using Formulas

o

Subitems

o

Creating a New Blank Project

o

Adding Resources to Items

o

Workflow Window

o

Project Properties

o

Details Screen

LESSON 3 – CREATE RESOURCES

LESSON 7 – CREATE OVERHEAD SCHEDULE

o

The Overhead Cost Schedule Window

LESSON 8 – PROJECT SUMMARY

o

Project Summary Window

o

Editing the Project Summary

o

Adding Basic Margin to the Project

o

Displaying the Project’s Tax Amount

o

Base Resources

o

The Resource Explorer

o

Creating Resources Manually

o

Importing Resources from a Spreadsheet

o

Copying Resources

o

Resolving Resource Conflicts

LESSON 9 – SPREAD RESULTS AND
PROJECT MESSAGES

o

Editing Resources

o

The Spread Results Window

o

Deleting Resources

o

Spread Result Notifications

o

Project Messages

LESSON 4 – CREATE SCHEDULE

o

The Direct Cost Schedule Window

LESSON 10 – REPORTS

o

Direct Cost Items

o

Accessing Reports

o

Creating Items Manually

o

Formatting Reports

o

Importing Items from a Spreadsheet

o

Printing and Emailing Reports

o

Editing Schedule Items

o

Displaying a Company Logo on Reports

o

Inserting Schedule Items

o

Deleting Schedule Items

LESSON 5 – CREATE COST ESTIMATE

o

The Cost Estimate Window

o

Items Locked from the Cost Estimate Window

o

Manually Adding Cost Estimate Information

o

Importing Cost Estimate Information from a
Spreadsheet

o

Copying Cost Estimate Information
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